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New Mexico Department of Public Safety Training and Recruiting Division 
How to Use the Instructor Guide / Student Study Guide Template 

 
 
This manual is not an Instructor Development course.  It assumes you are 
familiar with the Instructional System Design Model, developing Learning Goals 
and Objectives, developing testing instruments, and using Microsoft Word and 
PowerPoint.  The manual focuses on formatting your instructional content using 
the Instructor Guide Student Guide template. There are numerous possibilities 
which can be employed to construct a new Instructor Guide or convert an 
existing Lesson Plan to the Instructor Guide format.  This manual will offer 
suggestions based upon techniques already used and found to be effective.  This 
manual will use MS Office 2003 to illustrate steps.  If you use an earlier version 
or use another office suite such as Corel WordPerfect Office you will need to 
convert these steps to accommodate how your software applications handle the 
tasks discussed. 
 
Keep in mind, when working with graphics, your document size can become 
quite large.  Make sure your computer has adequate memory and hard drive 
space to accommodate working with large files.    
 
Creating an Instructor Guide from New Material 
 
It is recommended that you use the following sequence to create your Instructor 
Guide and Student Study Guide. 
 
First, it is suggested you turn off several default features in MS Word which 
includes the automatic numbering feature and the graphics canvas feature.  To 
do so follow these steps: 
 
 
 
 
Select the Insert menu item         Select AutoText from the dropdown menu 
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Select the AutoFormat Tab and uncheck the box labeled: Automatic bulleted 
lists 
 

 
 
 
 
 
 
 
 
 

 
 
Select the AutoFormat As You Type Tab and uncheck the Automatic bulleted 
lists box and the Automatic numbered lists boxes.  Click the OK button to save 
the changes.   
 

 
 
 
This will prevent MS Word from automatically indenting and numbering.  Another 
feature you will want to turn off is the feature which creates a drawing canvas 
with autoshapes.  To do this: 
 
Select the Tools menu item       From the drop down menu select Options 
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Uncheck the Automatically create drawing canvas when inserting 
AutoShapes box and click the OK button to save the change.   
 

      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This will allow you to create your text boxes for instructor and student notes 
without pushing the text to another page.   
 
Other defaults you may want to change include: 
 

• Set font and font size to ARIAL 12 PT. 
• Set Margins to Left: 0.75”, Right: 0.5”, Top: 0.5”, and Bottom: 0.5”  

 
Once the formatting issues are addressed develop the outline of your course. 
This will be used as a roadmap to developing the course content. 

 
Develop your content using your outline as a roadmap in a temporary Word 
Document.  The content should not use the traditional outline formatting. 
 
Once you have your course content, you can create your MS PowerPoint 
presentation. 
 
The MS PowerPoint presentation should follow the same strategy as the outline.  
It will act as a roadmap for the instructor and will be a vehicle for adding interest 
to the instruction by including graphics, imbedded audio and imbedded video.  
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You should use the course content to build your slides.  Slides should use bullets 
(animated or static) to give the instructor “Talking Points”. 
 
Once you have developed your presentation you will need to save a copy of it to 
a Word file which will create your “thumbnail” graphics to copy into your Instructor 
Guide.  To do this in MS PowerPoint: 
 
Select File, then Send To and Microsoft Office Word 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This will create a Word file with thumbnails of all of our presentation slides.  
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You will be presented with a box with 
options.  Click the Notes next to slides 
radio button, if it isn’t already selected and 
click on the OK button to create the file.  
The created file will be displayed in MS 
Word as a yet to be named document. 
 
 
 
 
 
 
Each slide number will be to the left and 
your notes will be to the right.  If you 
desire, you can also use your presentation 
notes as instructor notes in your Instructor 
Guide.  This will be discussed later in the 
manual. 
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To copy a thumbnail click on it with your mouse.  You will see the slide outlined 
with small boxes at the corners and midpoints of the border.  Next right click your 
mouse to access the drop down menu.  Select  Copy to copy the slide to the 
clipboard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Open the file containing your course content and place your cursor in the text 
where you want the slide to appear.  Again right click the mouse to open the drop 
down menu and select  Paste.  Your thumbnail will now appear.  It will, by 
default, displace any text on the page.  To get the text to wrap around, click on 
the thumbnail.  A Picture Menu Bar will appear 
   

 
 
Click on the Text Wrapping icon.  A drop down menu will appear.  Select  Tight, 
this will allow the text to flow  around the thumbnail.  At this point you can also 
drag the thumbnail to another location on the page and any text will flow around 
where you move it to. 

 
You can of course choose any of the text 
wrapping choices which may better fit how you 
want the graphic and text to behave.  A word of 
caution – Selecting some options such as 
Through may make it difficult to move the 
graphic once it is surrounded by text, and Word 
may place the graphic behind a larger graphic on 
the page.  If you get an undesired result, 
immediately use the undo 
function. 
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To create Instructor Notes: boxes select the Insert menu item.  
 

 
 
 
Then select Text Box 
 

Your mouse pointer will change from an arrow to a 
crosshair symbol (+).  Place the crosshair cursor 
where you want a corner of your text box to be 
anchored.  Holding down the left mouse button 
drag the cursor to create your box.  When the box 
is the size and shape you desire release the left 
mouse button. 
 
You have created your Instructor Note box.   
 

 
 

You can adjust the size or location of the text box by clicking on the box. 
 

As you move your cursor over any of the 
eight  ○  the cursor will change to a line 
with arrows at each end (↔, ↕) which you 
can use to enlarge or decrease the box 
site by holding down the left mouse 
button and dragging in the direction you 
want the box to increase or decrease. 

 
To enter text into the box, just click in it with the left mouse button.  A cursor will 
appear inside the box and you can begin typing.  If you find you need more 
space to type use the technique already described for enlarging the box.  If you 
find you made the box too large for the text you typed, then use the technique 
already described to decrease the size of the box. 
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You can adjust many features of the text box including the line used for the 
border, placement of text within the box and the color of the box (shading).  In the 
Instructor Guide format, Instructor Notes: text boxes are shaded a light yellow. 
To do this click on the box to display the shaded border with the eight ○.  As seen 
in the example below you want the shaded border not the diagonal line border.  
You may have to click on the box twice (with your cursor on the border of the 
box) to get the shaded  border. 
 

 
       This  border             NOT this border 
 
Next, click the right mouse button and a drop down menu will appear.  Select 
Borders and Shading… or Format Text Box… 
 
 

 
                  (1) 
 
 
 
 
 
                                                                                     (2) 
 
The menu that appears will depend on where your cursor is when you right click.  
If the cursor is inside the box and appears as the normal mouse arrow you will 
get the options shown in illustration (1).  If your cursor is on the shaded border 
and is the line with arrows at each end (↔) then you will get the options shown in 
illustration (2).  Regardless of which one you are presented with click on the 
highlighted selection. 
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A Format Text Box will appear 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Click on the Color drop down menu button to select the desired color. 

 
 
 
Select light yellow 
(bottom row, third from 
the left).  The click on 
OK to save the change.  
Your Text box should 
now be shaded  
 
 
 
 
 
 
 
 
 
 

This is a 
sample text 
box. 
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The Instructor Guide is designed to be printed on both sided of the page.  The 
odd numbered pages have the course content and the even numbered pages 
have a lined text box for Additional Instructor Notes.  You can insert the even 
numbered page Additional Instructor Notes text boxes as you go or do it when all 
the content has been inputted.  The latter is easiest.  To do this you only need to 
copy and paste the Additional Instructor Notes text box from the Instructor Guide 
template to the beginning of each even page.  The content you have already 
entered will be pushed to the next page.  You may need to make minor 
adjustments by adding or deleting a blank line to the top or bottom of the page. 
 
You may want to enter mandatory page breaks to preserve the content displayed 
on a page.  To add a page break: 
 
With the cursor bar at the bottom of the page you want to end and begin a new 
page, click on the Insert menu item and choose Break 
 

  
 
You will be presented with a Break menu.  Choose the Page break radio button.  
(it should already be selected as the default. 
 

 
 
 
If you use the Instructor Guide template you will only need to change the Header 
information to reflect the Block and Accreditation numbers.  If you are developing 
a lesson plan for an advanced, specialized or in-service course you can delete 
the Block and Accreditation number information and replace it with your Course 
name and Accreditation number.  
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Save your Instructor Guide under a different name to preserve the original copy 
of course content.  You will need it to create your Student Study Guide 
 
Creating a Student Study Guide 
 
If you developed your course content in a temporary MS Word document and 
kept that document, your student study guide will be easy to create.  Open the 
course content file.  Create a header and footer.  The Header should contain the 
name of the course and the term Student Study Guide. 
 

 
 
The Footer should contain the revision date for the material and the page 
number: 
 

 
 
Use line spacing 1.5. 
 
You may use full justification 
 
As discussed in the Instructor Guide, odd pages will contain the course content 
and the even pages will contain the Student Notes.  Use the procedures already 
discussed for the Instructor Guide here to insert the lined text box on the even 
numbered pages of the Student Study Guide. 
 
Any handouts will be included at the end of the Student Study Guide in the 
APPENDIX. 
 
Although not required you may want to create a cover page for the Instructor 
Guide and Student Study Guide.  Examples are included with the Instructor 
Guide template. 
 
Once completed you may want to create a PDF of each document for 
distribution.  The advantages are that the file size will be significantly smaller and 
the material will be viewable, but not editable.  If you want to distribute an 
editable copy you will need to distribute the MS Word documents. 


